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Introduction

This document explains how to connect a Wii Remote to your computer, in order to enjoy playing 

Sun Blast with this unique next-gen controller.

Note:  The  connection  should  also  work  with  other  devices  that  are  compatible  with  the  Wii 

Remote.

Connecting  a  remote  to  your  computer  is  not  hard to  do,  but  the  tools  you need may vary, 

depending on your operating system and hardware. The connection is made using a Bluetooth 

device, and the process is similar to the one for connecting your mobile phone to your computer.

Visit  www.sunblastthegame.com/support.php to download the latest version of this document.

You may distribute identical copies of this document to other parties.

Important:

Oblone Software and Sun Blast are NOT affiliated with Nintendo.

The Wii Remote is not designed to be connected to a computer.

The connection process is experimental, based on the informations freely available on the Internet.

Oblone Software does not take responsibility for any problem related to the use of the Wii Remote.

Nintendo, Wii and Wii Remote are trademarks of Nintendo.

All the names and trademarks appearing in this tutorial are property of their respective owners.

http://www.sunblastthegame.com/support.php
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Setting up the Wii Remote in Windows

General

Starting with Windows XP Service Pack 2 (SP2),  Bluetooth support  is natively provided by the 

operating system. Although some Bluetooth manufactures may provide drivers and support for 

Windows  2000,  this  tutorial  doesn't  provide  specific  information  for  this  particular  version  of 

Windows.

Depending on your Bluetooth device, in order to connect the Wii Remote to your computer, you 

will need to use a  wizard, which is provided by the Bluetooth dongle manufacturer, by a third 

party developer or by the operating system itself.

The Wii Remote will be detected as a Human Interface Device (HID), like a mouse or keyboard.

Sun Blast supports the following Bluetooth stacks: Microsoft, BlueSoleil, Widcomm and Toshiba.

Most of the Bluetooth dongles available on the market use one of the supported stacks.

You may need to install appropriate Bluetooth drivers to be able to connect the Wii Remote to your 

computer.

Tip 1. If  you are not sure what drivers and  what  Bluetooth stack you need to use with your 

Bluetooth dongle, you can find a list of compatibilities here:

http://www.wiili.org/index.php/Compatible_Bluetooth_Devices

and

http://wiibrew.org/wiki/List_of_Working_Bluetooth_Devices

Tip 2. It's not a problem if you can't find the name of your Bluetooth device in one of the lists. The 

process is similar with connecting your mobile phone to the computer,  but you must skip the 

pairing process (don't use a passkey). See the Generic Wii Remote connection tutorial.
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Tip 3. If you don't know the name of your Bluetooth dongle, you can try to install a demo version 

of BlueSoleil, which provides drivers for many Bluetooth devices and has an intuitive wizard.

You can download it from here: http://www.bluesoleil.com/download/index.asp?topic=bluesoleil6x

Note that the demo version of BlueSoleil has a transfer limit, which will automatically disconnect 

the  remote  in  a  short  time  after  the  connection,  but  it  gives  you enough time to  see  if  the 

connection works.

Tip 4. If you don't have a Bluetooth dongle or if it's not compatible with the Wii Remote, you can 

buy one that comes with BlueSoleil and it should work under Windows.

At this point,  you must have the appropriate Bluetooth drivers installed and you should know 

which tutorial is suitable for your Bluetooth dongle. If not, the first two links in the list below may 

explain things better.

Which tutorial should I read?

Generic Wii Remote connection tutorial

Connecting the Wii Remote in Windows Vista using the Microsoft wizard

Connecting the Wii Remote using BlueSoleil 2.x wizard

Connecting the Wii Remote using BlueSoleil 6.x wizard

Connecting the Wii Remote using the Toshiba wizard

Connecting the Wii Remote using the Widcomm wizard
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Which tutorial should I read?

It is very likely that one of the tutorials presented in this document is suitable for your device.

The lists from http://www.wiili.org/index.php/Compatible_Bluetooth_Devices and http://wiibrew.org/

wiki/List_of_Working_Bluetooth_Devices specify what drivers you need to install and how to use the 

wizard provided by the driver to connect the Wii Remote to your computer.

If you still don't know what to install and do next, try the following:

● Check if the wizard provided by the manufacturer is similar to one of the tutorials you find 

in this document or on the site presented above

● Check the Generic Wii Remote connection tutorial to see the general steps to connect 

your remote

● Check the tutorials provided by this site: http://www.wiimoteproject.com/bluetooth-and-

connectivity-knowledge-center/a-summary-of-windows-bluetooth-stacks-and-their-

connection/

● Try searching for an appropriate tutorial on the Internet

Generic Wii Remote connection tutorial

With any wizard you try the connection with, there are few basic steps that you need to follow:

● Start the wizard you use to connect your phone

● Put the remote into discoverable mode: simultaneously press the 1 and 2 buttons on the 

remote

● Start searching for the remote. It will be found as Nintendo RVL-CNT-01

● Wait until the remote leds stop flashing, then put the remote into discoverable mode again.

● Connect the remote without using a passkey, pin code or pairing process.

● Important: the  search  and  the  connection  must  be  made  while  the  remote  is  in 

discoverable mode. Make sure you press the 1 and 2 buttons simultaneously and that the 

leds are flashing while you search and connect the remote.
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Connecting  the  Wii  Remote  in  Windows  Vista  using  the 

Microsoft wizard

Bluetooth dongle used: TrendNet TBW-105ub (TrendNet drivers must be installed)

Step 1.

Plug in your Bluetooth dongle and start the wizard using the Bluetooth icon 

from the taskbar notification area.

Step 2.

Click on the Add... button.

Step 3.

Put  the  Wii  Remote  into  discoverable  mode 

(simultaneously  press  the  1  and  2  buttons  on  the 

remote), then click Next.

7
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Step 4.

Wait until the discovery ends.

Step 5.

The Wii Remote is now detected.

Wait until the remote leds stop flashing, then put 

the remote back in discoverable mode.

Select  the  Nintendo RVL-CNT-01  icon,  and click 

Next.

Step 6.

Check the Don't use a passkey option, then click 

Next.

8
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Step 7.

Wait while the connection is made.

Step 8.

At this point, the Wii Remote is connected to your 

computer.

Click Finish to close the wizard.

Note: If the wizard doesn't find or connect the remote, make sure it is in discoverable mode (the 

leds are flashing) while the wizard searches or tries to connect it.

You can now start the game.

Important: For this device in particular (TrendNet TBW-105ub), in the Sun Blast remote detection 

screen, you must activate the Use HID option, otherwise the remote will not be detected. 

Click here to see how to enable the Wii Remote within the game.

9
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Connecting the Wii Remote using BlueSoleil 2.x wizard

Step 1.

Plug in your Bluetooth dongle and start the BlueSoleil application from the Start 

Menu, or by double-clicking on the Bluetooth icon from the taskbar notification 

area.

Step 2.

Put  the  Wii  Remote  into  discoverable 

mode (simultaneously press the 1 and 2 

buttons on the remote).

Then, from the My Bluetooth menu, click 

on Bluetooth Device Discovery. 

Step 3.

The Wii Remote is now detected.

Wait until the remote leds stop flashing, 

then  put  the  remote  back  in 

discoverable mode.

Now,  right-click  on  the  Wii  Remote 

(Nintendo RVL-CNT-01),  then   click  on 

Refresh Services.

10
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Step 4.

Right click on the mouse icon, then click 

on Connect.

Step 5.

At this point, the Wii Remote is connected 

to your computer (notice that its color is 

now green).

Note: If the wizard doesn't find or connect the remote, make sure it is in discoverable mode (the 

leds are flashing) while the wizard searches or tries to connect it.

You can now start the game.

Click here to see how to enable the Wii Remote within the game.

11
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Connecting the Wii Remote using BlueSoleil 6.x wizard

Step 1.

Plug in your Bluetooth dongle and start the BlueSoleil  wizard 

from  the  desktop  shortcut,  or  by  double-clicking  on  the 

Bluetooth icon from the taskbar notification area.

Step 2.

Put  the  Wii  Remote  into  discoverable  mode 

(simultaneously press the 1 and 2 buttons on the 

remote),  then  double  click  the  Search  Devices 

icon.

Step 3.

The Wii Remote is now detected.

You should see a joystick icon with the name 

Nintendo RVL-CNT-01.

Wait  until  the  remote  leds  stop  flashing, 

then  put  the  remote  back  in  discoverable 

mode.

Now,  right-click  on  the  joystick  icon,  then 

click on Connect.

12
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Step 4.

Wait until the remote is connected.

Step 5.

The remote is now connected.

You can close the wizard.

You  can  see  that  the  Nintendo  RVL-CNT01 icon  and  the 

Bluetooth icon on the taskbar have green lighting.

Note: If the wizard doesn't find or connect the remote, make sure it is in discoverable mode (the 

leds are flashing) while the wizard searches or tries to connect it.

You can now start the game.

Click here to see how to enable the Wii Remote within the game.

13
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Connecting the Wii Remote using the Toshiba wizard

Step 1.

Plug in your Bluetooth dongle and start the wizard from Start Menu → Programs 

→ Bluetooth  → Bluetooth Settings or by double clicking on the Bluetooth icon 

from the taskbar notification area.

Step 2.

Click on the New Connection button.

Step 3.

Click on Express Mode (Recommended).

Put the  Wii  Remote  into  discoverable  mode 

(simultaneously  press  the  1  and 2  buttons  on 

the remote), then click Next.

14
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Step 4.

Wait until the remote is found.

Step 5.

The  Wii  Remote  is  now detected  (Nintendo 

RVL-CNT-01).

Wait until the remote leds stop flashing, then 

put the remote back in discoverable mode.

Select  Nintendo RVL-CNT-01,  then click  Next 

to start the connection.

Step 6.

Wait while the connection is made.
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Step 7.

The remote is now connected.

You can close the wizard.

Note: If the wizard doesn't find or connect the remote, make sure it is in discoverable mode (the 

leds are flashing) while the wizard searches or tries to connect it.

You can now start the game.

Click here to see how to enable the Wii Remote within the game.
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Connecting the Wii Remote using the Widcomm wizard

Bluetooth Dongle used: D-Link DBT-122

On Windows, connecting the Wii Remote using this dongle is problematic and it only works in 

Windows XP, with some of the DBT-122 dongles.  At the moment,  there is no official  driver or 

support for Windows Vista.

Step 1.

Plug in your Bluetooth dongle and start the wizard by 

right-clicking on the Bluetooth icon from the notification 

area  on  the  taskbar,  then  click  on  Bluetooth  Setup 

Wizard.

The name of the wizard may be different depending on 

your drivers.

Step 2.

Check  the  I  want  to  find  a  specific 

Bluetooth device and configure how this 

computer will use its services option.

Put  the  Wii  Remote  into  discoverable 

mode (simultaneously press the 1 and 2 

buttons on the remote), then click Next.

17
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Step 3.

The remote is now detected.

Wait until the remote leds stop flashing, then put the 

remote back in discoverable mode.

Select the Nintendo RVL-CNT-01 icon and click Next.

Step 4.

Very important: click the Skip Pairing button.

Step 5.

Now the remote is connected.

Click the Finish button to close the wizard.

18
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Note: If the wizard doesn't find or connect the remote, make sure it is in discoverable mode (the 

leds are flashing) while the wizard searches or tries to connect it.

You can now start the game.

Click here to see how to enable the Wii Remote within the game.
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How to enable the Wii Remote within the game

(Windows)

After connecting the remote to your computer, 

you can start Sun Blast and it will automatically 

detect it and set all up for playing.

If  it  doesn't,  or  if  the  remote  was  connected 

while Sun Blast was running, go to the  Options 

menu, then press the Detect Remote button.

In  the  Remote  Detection screen,  press  the 

Detect button.

Your remote should now be enabled. You can navigate using the remote buttons.

If it doesn't work, check the Use HID option and press the Detect button again.

Some  Bluetooth  devices  (like  the   TrendNet 

TBW-105ub dongle)  require  this  option  to  be 

enabled  in  order  to  properly  detect  the  Wii 

Remote.

That's it!

Go back to the Options menu and select your favorite control method.

Consult the game manual for details about the control methods.
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Setting up the Wii Remote in Mac OS X

Mac OS X 10.5 Leopard

Playing Sun Blast with your Wii Remote is officially supported only on Mac OS X 10.5 Leopard.

Step 1.

Make sure the Bluetooth is enabled and start Sun Blast.

Step 2.

Enter the  Options  menu, then press the  Detect Remote 

button.

Step 3.

In the Detection Screen, put the Wii Remote into 

discoverable  mode  by  simultaneously  pressing 

the 1 and 2 buttons on the remote, then press 

the Detect button.

21
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Step 4.

Wait for the remote to be detected.

Step 5.

A  message  will  tell  you  if  the  remote 

was properly detected.

That's it!

Go back to the Options menu and select your favorite control method.

Consult the game manual for details about the control methods.

22
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Mac OS X 10.4 Tiger

You can also play Sun Blast using the Wii Remote in Mac OS X 10.4 Tiger, but you have to deal with 

a well  known connection problem: you may need to try multiple times until  the connection is 

made.

The procedure is the same as for the Mac OS X 10.5 Leopard, but you need to delete the Wii 

Remote from the list of Bluetooth devices after each unsuccessful connection, like in the following 

picture:

23
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Setting up the Wii Remote under Linux

General

The official Bluetooth stack for Linux is BlueZ and it is included in the 2.4 and 2.6 kernels.

Sun  Blast  uses  the  BlueZ  D-bus  API and  supports  both  versions:  3.x  (legacy)  and  4.x  (new 

generation). You can find more informations about the BlueZ D-Bus API by going to:

http://www.freedesktop.org/wiki/Software/dbus

and

http://www.freedesktop.org/wiki/Software/DBusBindings

Most  Linux distributions  have the  Bluetooth support  enabled by default,  so it's  likely  to work 

without installing additional packages.

You can now read this:

How to enable the Wii Remote within the game

Or, if you want to make sure the Bluetooth support is enabled on your computer, or if you have 

troubles connecting the remote in Sun Blast, read this:

Testing the compatibility between your Bluetooth dongle and the Wii Remote

24
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How to enable the Wii Remote within the game

(Linux)

Step 1.

Make sure the Bluetooth dongle is plugged in and working properly, then start Sun Blast.

Step 2.

Enter the  Options  menu, then press the  Detect Remote 

button.

Step 3.

In the Detection Screen, put the Wii Remote into 

discoverable  mode  by  simultaneously  pressing 

the 1 and 2 buttons on the remote, then press 

the Detect button.

Step 4.

Wait for the remote to be detected.

25
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Step 5.

A message will tell you if the remote was 

properly detected.

That's it!

Go back to the Options menu and select your favorite control method.

Consult the game manual for details about the control methods.

If you have troubles connecting the Wii Remote to the computer, read this:

Testing the compatibility between your Bluetooth dongle and the Wii Remote

26
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Testing the compatibility between your Bluetooth dongle and 

the Wii Remote

(Linux)

First, test if the Bluetooth support is enabled.

Plug in your Bluetooth dongle, then open a console and type:

hcitool dev

The result should be something like this:

Devices:

hci0         00:19:3B:FA:64:CB

Then, put your Wii Remote in discoverable mode (simultaneously press the 1 and 2 buttons 

on the remote) and type:

hcitool scan

The result should be something like this:

Scanning ...

00:19:FD:CB:6D:80 Nintendo RVL- CNT-01

If the results are similar to the ones above, it means that the Bluetooth support is enabled and the 

remote can be found. 

Note: Some Bluetooth dongles which were supported by BlueZ 3.x no longer work with BlueZ 4.x. 

For example,  this happens for D-link DBT-122 dongle.  Also,  the Bluetooth support is broken in 

some Linux distributions that use BlueZ 4.x.

Next, you can check the compatibility between your dongle and the Wii Remote.
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For this, you have to install the  wmgui application (you will probably find the package in your 

Linux distribution).

To test the compatibility, click File → Connect.

Put  the  Wii  Remote  into  discoverable  mode 

(simultaneously press the 1 and 2 buttons on the 

remote), then click Ok.

If everything is working properly, when you press buttons on the Wii Remote, they will be shown 

on the Buttons section of the wmgui window.

You can press CTRL + A to see the data from the motion sensor.

You can now enable the remote within the game:

How to enable the Wii Remote within the game
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Setting up the Wii Remote in PC-BSD

General

The Bluetooth stack in BSD systems is implemented using the Netgraph framework, which has the 

following copyright:

Copyright (c) 2001-2002 Maksim Yevmenkin <m_evmenkin@yahoo.com>

The Bluetooth device drivers are available as a kernel module, which is not loaded by default.

To load the module, login as root and type: kldload ng_ubt

If the Bluetooth device is attached during the system startup, you can make the module to be 

automatically loaded by editing /boot/loader.conf and adding this line: ng_ubt_load="YES".

After this modification you must reboot the system.

Plug in  your  Bluetooth  dongle,  login  as  root  and start  the  Bluetooth stack with  the  following 

command:

/etc/rc.bluetooth start ubt0

Note: Don't connect the dongle in a USB hub.

At this time, the Bluetooth stack should be functional.

You can now jump to:  How to enable the Wii Remote within the game

Or you can test your Bluetooth functionality using the hccontrol commmand.

29
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See the examples below:

hccontrol -n ubt0hci inquiry

hccontrol remote_name_request 00:19:1D:BB:65:3B

If the results are similar with the ones above, it means that your Bluetooth device is functional.

See: How to enable the Wii Remote within the game
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How to enable the Wii Remote within the game

(PC-BSD)

Step 1.

Make sure the Bluetooth dongle is plugged in and working properly, then start Sun Blast.

Step 2.

Enter the  Options  menu, then press the  Detect Remote 

button.

Step 3.

In the Detection Screen, put the Wii Remote into 

discoverable  mode  by  simultaneously  pressing 

the 1 and 2 buttons on the remote, then press 

the Detect button.

Step 4.

Wait for the remote to be detected.
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Step 5.

A message will tell you if the remote was 

properly detected.

That's it!

Go back to the Options menu and select your favorite control method.

Consult the game manual for details about the control methods.
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